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Announcements & Events

SF Bay Photo Walks 

This is a group for anyone interested in exploring and 
photographing the SF Bay Area.  Beginners and all skill 

levels are welcome.  You can bring your iPhone or 
digital camera.  This group was started to help people 
meet other photography enthusiasts in a supportive 

environment.

https://www.meetup.com/SF-Bay-Photo-Walks/

ANNOUNCEMENTS!

Want to let other photography enthusiasts know about upcoming 

events, exhibits, workshops?

Send your info to vjs.1194@gmail.com and I will announce it in the 

the next Foto FanFare!

Bay Area Photo Scene 

Check out Bay Area PhotoScene 
for a searchable listing of San 

Francisco Bay Area exhibitions, 
talks, artist receptions, and 

workshops for people interested 
in photography. 

Bay Area PhotoScene

Stay Safe! 
Be Kind! 

Be Creative!

https://bayareaphotoscene.com/
https://bayareaphotoscene.com/
mailto:vjs.1194@gmail.com
https://www.meetup.com/SF-Bay-Photo-Walks/
https://www.meetup.com/SF-Bay-Photo-Walks/
mailto:vjs.1194@gmail.com
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Presidents Corner…
by Doug Stinson

I’m pleased to see more clubs are figuring out ways to conduct cri7ques and 
judging remotely. My own Fremont Photographic Society conducted its first 
remote mee7ng in April, and it went well. The best part for me were the 
members we have not seen in a long 7me who joined in! I’m curious if any 
clubs have conducted their educa7on nights remotely. Has anyone figured 
out a way to recruit new members in this 7me of shelter-in-place? Please 
share your experiences by wri7ng a short note for this newsleJer. 

We started training assessors for the new PorLolio Compe77on this month. Twelve people have 
completed the first lesson. We should be in good shape for cri7quing the porLolios once the compe77on 
closes on November 1st. Crea7ng a porLolio is an excellent way to take your photography to the next 
level. As Ansel Adam said, “you don’t take a photograph, you make it.” There is no way to just “take” a 
good porLolio. 

The N4C Board is working on some clean-up of the rules. We don’t expect any significant changes, but 
we have learned some rules were less clear than they needed to be. One thing we plan on doing is 
combining the Division Defini7ons and the Rules into one document – everything in one place. We are 
doing some restructuring – making it clear what items need to be understood by the average compe7tor, 
and what things only impact people running the compe77ons. Terms are being beJer defined. We are 
also conver7ng some long-winded, complicated text into simple tables. Nothing is final un7l approved in 
September when they will be put up on the N4C.org website. New rules take effect the following 
January. 

Which brings me to another point. I’m o[en asked about what the N4C Rule is about some issue. I 
struggle to not give an answer! It’s hard! Instead I go to the N4C.org website and look it up. It is 
embarrassing how many 7mes I’ve misremembered a rule. And you should hear some incredible 
misstatements of the rules I’ve heard stated with absolute authority. It’s complicated because, while N4C 
is strict with the Division defini7ons, we otherwise try to keep our rules to the minimum necessary for 
the smooth running of the Interclub and Annual compe77ons. We try to keep out of the opera7ons of 
the clubs as much as possible (that’s in our Bylaws). As a result, some rules and policies may vary 
significantly from club to club. Don’t assume that because your club operates a certain way, it’s a N4C 
rule. Look it up! 

The results of the Member Survey and the Club Officer’s Survey were distributed to all N4C Board 
members, club presidents and club vice presidents. We haven’t had a chance to dig deeply into the 
results, but one thing is clear: the biggest obstacle to implemen7ng programs is the lack of volunteers. 
The good news is, this is something totally within our control. I know when I volunteer, I inevitably get 
more out then I put in. So, talk to your club officers. Volunteer, and make your club more valuable to 
yourself and to your colleagues. 

That’s it for now. Be crea7ve! Have fun! Be safe! 
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What Does One Judge Look for in an Image? 
by Joan Field, APSA, HN4C 

 Judges come in all shapes and sizes. As you know, the camera club judge’s opinions are 
quite subjective, depending on his or her experience — whether the judge has been doing it  
years or is much more educated in the photographic genre and more relaxed in front of an 
audience. 
 The newer or inexperienced judge may rely more heavily on the basic rules of 
photography, while the more experienced judge may be open to more experimental work by the 
maker. 
 A judge’s experience can be determined by 

• How long has he been judging? (This should be taken with a grain of salt) 
• What books has he read? 
• How many museums has he visited? 
• What photographic magazines doe he subscribe to? 
• Did her or she have any formal art or photographic instruction or education? 
• Who are his or her mentors? 
• Is the language of art easy for the judge to use? 
• Has he kept up with the latest photographic methods and equipment? 

What are the most important aspects of a photo? 
What is the maker trying to convey to the viewer? 
The story is paramount. 

There are two classifications in camera club photography. 
(1) Artistic 

• Pictorial (or color) 
• Monochrome 

(2) Story-telling 
• Nature 
• Travel 
• Journalism 
• Creative 

TITLING 
• Artistic: Titling is not crucial in Pictorial and Monochrome. The title might help, but these 
images are judged more by analyzing the artistic endeavor or story-telling ability of the maker, 
rather than the title. N4C, however, has recently stipulated that all titles be read either by the 
judge for projected images,  or by a helper for the prints. The bottom line in the Artistic 
classification is that the titles are not critical to the judging process. 
• Story-telling; These images require a comprehensive title that clarifies the story and educates 
the viewer. The limit is 200 characters. 
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Each division has a different title characteristic. It is so important that the judge understands 
what the maker is trying to convey. 

NATURE: 
Since here the story is indispensable, it is necessary to 

tell it. For instance, a photo of a male flamingo mounting a 
female for copulating should be titled something like -” Male 
Chilean Flamingo (Phoenicopterus chilensis) in Copulating 
Position on the Back of Female. Note that the Female needs to 
Balance Using her Head as a the Third Leg of a tripod.”). 
The title should include all of the newspaper requirements 
answering the questions “where,” “why,” “what”, “when” and 
“who.” (the 5Ws). It may take a fair amount of space, but you 
have 200 characters. To quickly count the number of 
characters, put your caption in Word, go to Tools>Word 
Count. It also shows the character count. 
The more information you can give the viewer, the better the 
chances for a win. 
Gene Albright will notify you or your delegate to N4C if your 
image title is more than 200 characters. 

 
You need to specify, especially for a close-
up, that it is the portrait of the animal, or 
discuss some characteristic, such as a beak, 
while assigning the correct name to the 
animal. (“Portrait of a Giant Ant-eater.”) 
Some nature images do not have a valid 
story associated with them because the 
subject is just posing for you. You could call 
this photo of the below image:   

“A Study or Portrait of a Black-Necked Stilt” or “The 
Black-Necked Stilt is Aptly Named” Another approach would 
be to give some details about the bird such as “The Black-
Necked Stilt is commonly found in wetlands and mudflats. Its 
diet consists of aquatic in- vertebrates, including crustaceans 
and mollusks.” 

(Continued on p. 7) 
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Photo Opportunities in 
the Bay Area!

Las Trampas Regional Wilderness Park, San Ramon

Del Valle Regional Park, Livermore 

Sunol Regional Wilderness, Sunol

Golden Gate Park, SF

Anthony Chabot Regional Park, Castro Valley

Sycamore Grove Regional Park, Pleasanton

Ed R. Levin County Park, Milpitas

Shadow Cliffs Regional Recreation Area, Pleasanton

Coyote Hills Regional Park, Fremont

Don Castro Regional Recreation Area, Hayward

Lake Chabot Regional Park, Castro Valley

Pleasanton Ridge Regional Park, Pleasanton

Reinhardt Redwood Regional Park, Oakland

Quarry Lakes Regional Recreation Area, Fremont

“In every walk in 
with nature 

one receives far more 
than he seeks” 

John Muir
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• NO-NO’S in Nature Titling: 
• Do NOT attribute motives to the subject it if you are guessing about what he might 

be doing. Such as “Great Egret Looking for Prey in the Stream.” I suggest changing it to “Great 
Egret in Stream normally seeks small fish, crayfish, 
dragonflies, and shrimp.” 

• Above all, do not use cutesy titles. such as “Please 
pass me a Berry.” A correct title would be “Two Cedar 
Waxwings (Bombycilla cedrorum) in Eating Frenzy in 
Winterberry.” Although showing the Latin Name shows 
an endeavor to learn more about the subject, it is not a 
requirement in Nature titles. 

JOURNALISM 
Here, the title (or caption) is almost as important as the 

photo. The judge will be looking for the 5 W’s here, 
especially. Try to remember to include the date, as well as the 
other four pieces of information.  Where you can, as in Nature, 
provide up to four images to show your story, each sequence image needs an appropriate title, as 
does each single image. Be careful, when choosing a sequence of images, to make sure that they 
each add something critical to the story. Many times sequences can be made stronger by 

dropping one, or even two, images. 

Titles for typical Journalism sequence: 
1.  Championship Dog Surfing Competition, 
Pacifica, CA,, August, 2018 [1] Owner sends off 
dog on surfboard 

3.   Championship Dog Surfing Competition, 
Pacifica, CA,, August, 2018 [3] Side View of 
Dog Surfing 

4.   Championship Dog Surfing Competition, 
Pacifica, CA,, August, 201 [4] The Winner on 
Display 
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In my opinion, Journalism allows for cute titles that will make the audience laugh or react. Some 
judges, however,  may still require more information. You take your chances. 

TRAVEL 
The biggest mistake in titling Travel images is to leave 
out the name of the place. I judged at Palo Alto not too 
long ago and their travel images, although excellent, 
failed to tell where they were. They were not an N4C 
club, so it was not so critical for them as it would be for 
you. 
Describe what is happening, e.g  “At Market, while 
Waiting for Next Sale, Mother Plays with Child who is 
Playing with Money, Antigua, Guatemala.” In this title is 
included the story, the place and what makes it 
interesting. I could have added a date, as well, although it 
is not so necessary as in Journalism. 
CREATIVE 
The creative title need not be long however, it should be 
creative.  The last thing we need is a title that tells us 
exactly what we are looking at and what the maker did to 

it. A typical poor title would be “Raindrops on Black 
Glass.” Instead, how about “Black Beetles Moving Relentlessly Toward Dinner.” 

WHAT DOES THE JUDGE LOOK FOR BESIDES AN APPROPRIATE TITLE?? 
Guatemalan Mother with Child at Market, 

GENERAL CONCEPTS © Joan Field 2011 

(1) Impact or Wow Factor 
The impact or Wow Factor may be the single biggest thing 
that influences the Judge. Some judging reviews have given it 
a 50% weight value. Many judges reduce the value of 
IMPACT, feeling it  
takes away from looking at the work the maker did to achieve 
his goal.  However, often it is impossible to ignore. What 
makes an image that achieves such great value? 
Answer: One that takes your breath away and provokes 
emotion in the viewer. It is usually a combination of all of the 
aspects of great photography: outstanding lighting, creative 
subject matter, excellent composition, colors that complement 
each other, painstaking technique and competent post-
processing. Here are a few examples: 
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These 
images are 
few and far 
between, in 
general, so the judge 
falls back to images that are excellent, very good 
and good to look for the best choice for awards. 
The relative values of excellent to good, of course, 
depend on the judge’s estimation of the following 
values: 
(2) Subject matter: 

• Is it unusual? Does it catch your attention? 
• If not, has it been approached photographically in an unusual 
way? This would be expected of such iconic topics as 
Yosemite Valley,  Old Faithful, and the Grand Tetons, for 
example 
i• Uncommon angles or viewpoints will help add more interest 
to the images.  
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• Seasonal Impact  

(3) Composition 
Some makers have a built-in sense of composition; they are lucky. Others have to learn it. 

 Some basic compositional rules are; 
 • Rule of thirds or Golden Rule 
It has been shown over the ages that objects in a 
piece of  art placed in the 1/3 nodes of a ruled 
box or frame seem to please the viewer more. 
Placing a subject in the middle of the frame 
may give the entire picture a static sense.  That 
is why in camera clubs you rarely find a 
horizon line at the half-way point between top 
and bottom of the frame. The maker should 
choose which part of his image is more 
important, the land or the sky and move the 
horizon accordingly. This would involve 
cropping, of course. A little-known trick in 
Photoshop and Lightroom will produce the Rule of Thirds, the Golden Rule and the Golden 
Spiral or Fibonacci Spiral as an overlay on your image to help you with cropping choices.. Just 
make sure the crop tool is activated and that there are crop handles around your photo.  Go up to 
the menu bar and locate the Grid Option icon (looks like whatever it’s set on) to the left of the 
gear. Pull down and choose your preferred grid: Rule of Thirds, Golden Rule (which is slightly 
different)  or the Golden Spiral. Set the Grid to “Always Show Overlay.” To move the spiral to 
different positions in the frame hold down the shift key and hit the letter “O.”  (Objects located in 
the Golden spiral where it curls in are also in pleasing positions for the viewer). 
A symmetrical object, however, is often best shown as totally symmetrical.  



May 2020 11

• Compositional Balance: Try to find a 
balance between two objects as you frame your 
shot. They do not have to be the same size. A 
rock can balance a sea stack, for instance. In 
fact, if there are two large subjects in the image 
you will create a ping-pong effect, where the 
eye goes back and forth between the two,  
competing for main subject. 

• Cropping: Many a photo will be 
improved with the proper cropping. If you have 
too much sky or foreground, they can easily be 
removed by using the crop tools in Photoshop or Lightroom. Although some photographers feel 
that you should do your cropping in camera, I have yet to discover where it says that Mother 
Nature created the best compositions 
in a 2:3 ratio. Commonly cropped should be too much sky or too much land, neither of 
which offer much to the photo. Often, the sky is quite bright and removing most of it will 
enhance the colors in the remaining image.  Frequently, a slim jim or panoramic view will tell 
your tale most pleasingly. 

• Subject as Main Focal Point: You should look toward having a subject that will attract 
the viewer’s eye quickly. Among others, this can be by the characteristic of its nature, by a color, 
or by a brighter area, which will draw one’s attention. 

• Leading Lines: If possible and it makes sense, use leading lines to take us to the 
subject. They also give the image a sense of depth. The famous S-Shaped Curve also counts as a 
leading line. 

•Geometric Shapes: 
Triangular, circular, oval,  and 
rectangular shapes found within an 
image can lend it more strength 
compositionally. They often 
provide a means for the eye to 
circle within the frame eliminating 
the problem of being thrown out by 
some other element. 
• Is Image Straight in the 
Frame?: Many of us take our 
photos as a slight angle, especially 
if hand-holding. Do not enter an 
image in competition that has not 

been straightened. Using either the crop tool or the Transform tool in Photoshop, you can rotate 
your image into proper orientation. Enable a grid or pull straight lines from the ruler. If 
keystoning has occurred (elements on the side sloping inwards or outwards), you can correct this 
with either the Transform tool or the Lens Correction Tool found under Filters. You may prefer to 
keep extreme keystoning as a dominant element of the photo. 
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Focus Stacking Examples © Joan Field 

(4) Technical Criteria 
• Focus: Unless you are trying for something really unusual, perhaps in Creative, there 

should be at least one portion of the image that is in sharp focus. The use of selective focus can 
be very impactful in getting across a concept or in producing a work of art. When the entire 
frame needs to be in sharp focus, the maker should first consider the use of the Hyperfocal 
distance, which is setting one’s camera focus manually to about 1/3 the distance from where you 
are standing. This produces the greatest DOF possible after you have already set your Aperture to 
a high value such as f22. 
 Another way to achieve sharpness is to use 
a wide-angle lens., which tends to magnify 
distance between objects while allowing greater 
depth of field.   
 The third way to achieve great DOF is to 
use focus stacking. Focus stacking works fairly 
easily for landscapes since as few as three different 

frames 
will be enough to “stack” using Photoshop or 
Lightroom to produce a final image completely in 
focus. In Photoshop, choose your three images, go 

to File> Automate>Photomerge. If you use Focus Stacking for a close-up, you must be on tripod, 
but for a landscape, you can get away with hand holding. Just be as steady as possible. 
 • Exposure: You do not want the image to look over- or underexposed when being 
projected.  Be sure to check your exposure value (EV) to make sure it is set at 0 or close to it. If 
you are shooting in RAW, you will have the ability to 
generously lighten or darken your image when in Lightroom 
or Adobe Camera Raw in Bridge. This can be a true savior 
on occasion.  
Check your histogram to make sure that the right-hand side 
is not bunched up against the edge of the graph. If so, this 
means that you have overexposed areas on your image. 
Typical would be photographing a white egret, especially in 
the sun. The bright white feathers would look burned out 
with no detail. Usually,  minus1.5 - minus 2 5 EV will 
resolve that problem. If there are areas in your image that 
are too dark (histogram bunched up on the left side), you 
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also want to adjust for that or you lose shadow detail. 
 Since most of the photographic data is found on the 
lighter side of the histogram, if you take your photo a little 
overexposed, you may be best off. 
 You may, however, want to experiment with over- or 
underexposure to give a special effect. Underexposure produces 
low key, while overexposure produces high key images. 
 • Shadows and Highlights: You have to be careful in 
lightening the shadows as it can easily be overdone, giving a 
washed out look to that part of the image. If using Shadows, do 
so in Adobe Camera Raw or Lightroom. The controls there are 
less harsh than those using Image>Adjustments>Shadows/
Highlights in Photoshop. You can reduce the highlights you don’t 
want, provided there is some information residual in the RAW 
image. That is also why checking the histogram is so important. 
If you put Garbage In, you get Garbage Out (GIGO). 
 • Over or Under Saturation: One mistake that is 
sometimes made when enhancing an image i, to oversaturate it, hoping that the bright colors will 
call attention to it or make it more significant. If overdone, it is an immediate alert to the judge to 
disqualify the image in his mind. Making your image more or less saturated can be done either 
by using the Saturate or Vibrance controls in both Lightroom and Photoshop Adobe Camera 
Raw; vibrance is less conspicuous. Saturation increases the intensity of the color of every pixel. 
Vibrance is a smart saturation, which increases the intensity of less-saturated colors more than 

the colors that are already saturated. So, 
clearly, it is the method of choice. Another 
way to saturate individual colors, which 
may be all you need, is to go to Hue/
Saturation in your image enhancing 
program of choice, choose your color of 
choice and increase or decrease the 
saturation slider until you see what you 
like. This is a very useful tool, and is 
perfect for sunsets, landscapes and other 
images that just need selective color 

tweaking. 
 • Over Sharpening: We all hope for an image that is nice and sharp. There are ways to 
do this that do not make it look like you have overindulged. You can check your sharpening by 
magnifying the image considerably and looking at the noise. When over-sharpened, the noise is 
quite obvious. Often it is a battle between sharpening and noise, both increasing with additional 
sharpening. A trained judge will spot it immediately, if overdone. 
 Here are a few ways to increase sharpening without destroying the image: 
  • Careful Use of the Sharpening Tool: If you need to sharpen the eyes and beak 
of a bird, e.g., you can use this tool with discretion. I always reduce the opacity of the tool to 
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about 25% and limit the areas in the image to be sharpened. Be careful it doesn’t produce too 
much noise. 
 • High Pass Sharpening: Instead of using Smart Sharpen, you can use the High Pass 
tool., which is found in Filters>Other. Copy your layer (Command-J), working on the new layer. 
High Pass will give you a silvery look. Adjust the amount to less than 5. Then use the Soft Light 
or Overlay blend mode found above the layers. You will immediately see how much sharper your 
image has become. If too sharp, undo it and try a lower setting on the slider. This method helps 
eliminate the fringe effects that are often seen in over-sharpening. 
 • Topaz Sharpen AI: This is a relatively new program put out by Topaz. It costs about 
$19. It is quite useful in sharpening photos that are only slightly soft, and avoids the usual over-
sharpening problems. 
 • Border Patrol and Removal of Small Eye-Catching objects: In the Artistic areas, 
anything you can do to make the image look better is allowed. It is always important to check 
around your borders to make sure there are no bright or dark spots that catch the eye, no 
intrusion of unwanted objects such as a dangling tree limb or similar. These can usually be 
corrected with cropping or the use of the clone tool. Look for unwanted elements within the 
image as well, and remove such objects as an isolated piece of paper. 

(5) Special Divisions 
 Nature: `There is no question that a good nature story will do better than a beautiful 
capture of a nature object.  The story is paramount, but still good pictorial elements as listed 
above are important to the judge, as is the title.   

Nature images can be taken 
anywhere, including our zoos, but 
should not be obviously of a 
captive animal, showing fences or 
concrete structures.  
A good nature story will show the 
subject doing something that is 
typical of the species, such as two 
males fighting, the struggle for 
food and the rearing of babies. 

Unusual activities are particularly strong. Domestic or feral 
domestic animals of any kind, including wild  horses and 
camels are not allowed. 
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Authentic Wildlife: Only for nature images 
going to N4C. It is not judged at camera club. If 
you want to compete at the N4C level in 
Wildlife, it is required that you check the 
Wildlife box when entering your image 
provided the image was indeed taken in the 
wild. No zoo or animals taken in any  form of 
captivity are allowed in Authentic Wildlife. This 
means no photos from wildlife ranches or 

owned and confined safaris, e.g. the safari which is part of the San Diego Zoo in Escondido or 
the one near Santa Rosa. 
 Travel: The definition states: “A Photo Travel 
image must express the feeling of a time and place, and 
portray a land, it’s distinctive features or culture in its 
natural state.” Travel images theoretically can be taken 
anywhere, provided the outcome shows a sense of place. 
In travel, it is discouraged to have a close-up of a person 
in native dress without having a background that 
indicates the country of origin, as well. The definition is 
somewhat confusing, and may yet be changed. One 
problem is the concept of a time, which seems to have 
nothing to do with travel. Perhaps it is referring to 
ancient constructions such as the pyramids in Egypt.  In 
any case, the images that do the best in travel are those 



May 2020 16

including  people, preferably in native garb, doing something typical,  with a background that 
could clearly be the country named. Landscapes or buildings that are well-known are often very 
acceptable travel images, but since they are iconic, one should try to use an unusual angle , 
position or lighting situation.  Remember, the title should include not only what the image is 
about but also the country of origin. 
 A common mistake is to show an object such as a waterfall, that is not immediately 
recognizable and tell us that it is such and such a waterfall in such and such a country. You have 
heard many judges say “ That could be anywhere.” Since this is true, it is not a strong travel 
image by our current definition.  However, a well-known-falls such a Iguazú in Brazil or 
Multnomah in Oregon tells us immediately where it is because they are both familiar images. 
 One other controversy in Travel is the question of how acceptable is a set- up for the 
tourist, such as the jumping contests of the Masai-Mara or the Guilin fishermen with cormorants 
taken at sunset with the old costumes on the fishermen in their typical boats. At the moment, 
there is no rule that disallows this, but it is a bit disingenuous. 
 Journalism: The best Journalism images evoke an emotion, be it empathy, fear, awe, 
excitement, happiness or despair. There are several types of Journalism images; The definition is: 
“Journalism entries shall consist of pictures with informative content and emotional impact,  
including human interest, documentary and spot news.” 
 The main no-no is that no setups are allowed in Journalism. 
 Any emotion elicited from the audience, such as a good laugh or an in drawing of breath, 
is a sign of an image that has worked well and the judge 
should give it an award. 
 Journalism is one of the more difficult areas of 
photography. To succeed, you need to carry a camera with 
you at all times, so you can capture the moment. Sports or 
event photography are areas that can be planned in advance 
and can produce some wonderful images. Think of the Pride 
Parade or a rodeo, car racing, and high school track events. 
A common mistake especially for newer club members is to 
try to convert a good travel image, such as a Guatemalan 
woman weaving into Journalism. 

 People doing their jobs which can be caught at any time do not 
make good Journalism images. What does is something you 
stumbled across, which is a onetime event, such as a dog licking 
someone’s face, a child trying to reach a water fountain who is a bit 
too short, or peak action shots. 
 Creative: Here is the greatest area of subjectivity in judging. 
Anything goes as long as it starts with you own photos. 
 The N4C definition has been expanded from the original PSA: 
“Creative photography is producing an image through the use of 
imaginative skill or originality of thought,  including the altering of 
reality. No image should be eliminated from competition simply 
because it looks realistic, provided it shows originality of concept.” 



May 2020 17

 A creative image should be striking, compositionally strong and with colors that enhance 
it. The Creative Concept should be foremost. 
 With the N4C definition, we have given our 
photographers a chance to produce an image that on the 
surface looks realistic, but is actually a very creative 
concept. One example  is “The Portrait of Dorian Banana,”  
a takeoff on “The Portrait of Doran Gray.” It looks realistic; 
its creativity is in the concept .This is one of the reasons 
N4C expanded its definition. 
 Creative images can be produced many ways: 
  • In Camera 
  • Motion (slow shutter speed, up and down 
side to side, and circular) 
  • Multiple exposures (no longer available in the Nikon D750) 
  • Capture of the object in camera from an unusual viewpoint or crop 
  • Working with an image or images you have taken to make them more    
   imaginative. You can use filters from third party apps or programs as long as     
they do not add photographic elements that you did not photograph, such as a new sky. 
Adding your own sky is fine. 

 • Composites of your own work, preferably pre-
conceived. This includes the use of melding two or more 
layers together such as blending your own created 
textures with an image, as well as the combination of 
items that tell a story when put together in a way that 
would be virtually impossible to reproduce by straight 
photography. 
  
To do 

really well 
in the Creative division, you need to spend some 
time thinking about what you want to create. What 
is your concept?  Here is an example of a pre-
conceived composite called “The Land of Pisa.” 
The concept was to have everything slanting in the 
same direction as the tower. The maker collected 
many items such as the trees, the tower, the cows, 
the people all separately and combined them. In 
those days, the use of third-party applications to 
create elements was allowed, so the Italianate floor and sky were created in Kai’s Power Tools, 
no longer available. The final composite was purchased at the Alameda County Fair by the Fair 
Committee. 
 Here are some more examples. I include them because, personally, they are my favorite 
type of creative image:  
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Not all creative images require such an elaborate production. There are many ways to produce 
great Creative images (see above list) 
 Here’s some things to avoid, if possible, when entering creative: 
 • The use of a single filter to make the image look “different.” It belies the creative 
concept. I have seen many images that are beautiful using paint-type filters such a oil painting 
and watercolor do well in creative because the original image was beautiful, but, in fact, they are 
not creative; the maker has not thought how to make his image unique or mystifying. In my 
opinion, the use of the swirl or some other simple filter like extrude is not sufficient to make a 
great creative shot unless something more is done to the image. 
 • Another common error may be to enter something that is just a straight photo, 
such as a close-up of the bark on a eucalyptus tree. It creates an abstract, but is it really strong  
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enough to do well in creative? Sometimes deliberately or accidentally blurred images are 
satisfactory with the right title. 
 • In-camera motion can be acceptable: 
Consider the large number of tress with applied up 
and down camera motion you have seen. Attractive, 
but a cliché. Multiple exposures can also be quite 
impressive,  ranging from two which could be as 
simple as an in-and-out -of -focus image of the same 
object to many of the same object with small motions 
in between. 
 • What is not acceptable at all is the use of any 
apps or filters that introduce a new photo-like aspect 
to the image. Typical would be inserting a sky that is 
not yours, and frames that are not self-made. Also the 
use of Textures that are created by other folks, are not 
allowed. You can create and collect your own textures, skies and borders into handy files, which 
are perfectly all right. 
 In the long run, the judge will have to trust the maker that all images involved in his 
creative effort are his own. 

Prints  
Everything above applies to prints, as well. However, they have a few extra characteristics to 
keep in mind as you enter them: 
 • The choice of print paper. This can determine how well your particular image stands 
out. Glossy paper helps improve contrast, for instance. Art paper can really enrich the 
presentation of fine art images such as flowers. 
 • The presentation should be clean and neat. Whether you paste your print to a board of 
some kind or cut an elaborate mat, make sure it is done well. 
 • Whether you cut the mat to partly cover the picture or you leave a white border around 
the edge of the print. Leaving a border has two advantages: 
  (1) It prevents cutting off something on the edge of the print such as feet or a 
hand, which could end up hidden under the mat 
  (2) It makes the print look more professional. It shows immediately that the maker 
has cut his own mat and not used precut mats, while at the same time giving a sense of double-
matting. 
 • The use of pre-cut mats There’s nothing wrong with this, but it does limit the shape of 
your print, or makes any cropping of the print look terrible because of the lack of fit in the pro-
cut. 

 Conclusion: 
The most important part of your photography is that you enjoy it. You should not take photos to win in 
camera club, or to please the judge, but to express your enthusiasm about your hobby. Always be open to 
new ideas and be willing to experiment. That’s how you grow in photography. 
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Making the Most of Our Shelter-in-Place 
By Vicki Stephens


The initial shelter-in-place recommendations didn’t shake me as much as I thought 
they would.  We happened to be visiting our daughter and her family in Michigan when 
the lockdown orders came in both California and Michigan.  We decided to stay put in 
Michigan, as we had good company and peaceful surroundings.  I couldn’t think of a 
better place to hunker down for what would be two months.  

My four-year-old granddaughter’s school/daycare was, of course also closed.  I’m a 
retired first grade teacher and it seemed fortuitous that I was there to take up her pre-K 
education.  As with most kids, a familiar structure at this time can be helpful to keep 
them feeing in control and grounded…and it gave me a focus.

We live on Scotch Lake, a small 
lake in the Detroit suburbs.  The 
wildlife is abundant and I find I’ve 
become a bird lady.  Birds…
photography…you can guess how I 
spend lot of my time in Michigan, 
sometimes sharing my interests 
with my grandkids.  So, I decided 
to do a bird unit in “Grandma 
School”.  We read bird books, took 
nature walks, viewed birds through 
binoculars and did a bird count, 
charting the count on a 100’s chart.  
We saw 100 birds in 4 days!  I also 
set up my camera on a tripod in our 
bay window and we watched, discussed and photographed birds together. She was a 
quick learner! Together we created a book called Birds of Scotch Lake on Shutterfly.  I 
love that we have this project to keep and represent our time together during the Covid 
19 pandemic.  It’s a bit of art and happiness for me.  She most likely won’t remember a 
whole lot about this time when she’s an adult, but her parents will, and they’ll remind 
her about her schooling at our house and this special time we had together, which 
resulted in our picture book.  I had no idea this scary world experience would provide 
such a wonderful one with my granddaughter! 


If you have a story or experience to share during your shelter-in-place, please send it 
my way to vjs.1194@gmail.com. I’d love to feature it in our next Foto FanFare!


The Shutterfly link to Birds of Scotch Lake is below.  It is for viewing purposes only and 
is not meant as a solicitation!
 https://link.shutterfly.com/e/ihhtg6KDi6  
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April Competition Results
Pictorial - Projected Images (Judge - Gary Crabbe)
Basic Level (25 entries)

Award Title Member Club

1 Steam coming out my ears Michael Carpenter Peninsula

2 2017 Solar Eclipse, Ochoco National Forest above Prineville, 
Oregon Fritz Carlson Santa Rosa

3
The Sunday after Easter feeding his friends a short walk from the 

silent bells of Notre Dame. (Paris, France, July, 2018)
Jonathan Honneymann Millbrae

4 Nicasio Mirage Gary Hromada Marin

5 Keyhole Rock in Pfeiffer Beach, Big Sur Kenneth Mark Berkeley

HM Bells announcing spring Marcy Zimmerman Diablo Valley

HM Double Rainbow at Kawai Nui Marsh in Kailua, Hawaii Kenneth Mark Berkeley

HM
Natural seafoam bubbles on kelp. Pfeiffer Beach, Big Sur, 

California. 
Angela Grove Marin

Pictorial Projected - 1st - Basic 
 

Steam coming out my ears  
Michael Carpenter 

Peninsula Camera Club 
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Pictorial Projected (cont’d)
Intermediate Level (26 entries)

Award Title Member Club

1 Canine Portal Sheri Oster Santa Rosa

2 Oculus William Newton Berkeley

3 Cathedral Ceiling Gary Oehrle Livermore

4 Jun 18, 2019 - A humpback whale that was splashing around 
Alameda, Ca. Rafael Ramirez Alameda

5 This young village girl from Laos is not very happy having to carry 
her brother. Phil Meginness Livermore

HM Stare Down with a Burrowing Owl Pat Page Contra Costa

HM The Way In Karen Gideon Marin

HM Umbrellas John Drake Berkeley

Pictorial Projected - 1st - Intermediate 
 

Canine Portal 
Sherri Oster 

Santa Rosa Photographic Society 
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Pictorial Projected (cont’d)
Advanced  Level 30 entries)

Award Title Member Club

1 Radiance Captured Linda Koski Villages

2 Delicate Landing Polly Krauter Livermore

3 Taking a break Udo Klein Contra Costa

4 Color Wheel Trisha Brown Santa Rosa

5 Timeless Alex Valcohen Diablo Valley

HM Assassins Apothecary Steve Kessler Peninsula

HM Horses at sunrise on Horse Hill Phil Shaw Marin

HM Three Hundred Piece Puzzle Bill Chambard Contra Costa

Pictorial Projected - 1st - Advanced 
 

Radiance Captured 
Linda Koski 

Villages Camera Club 
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Masters Level (30 entries)

Award Title Member Club

1B Coming down for a landing Stephen Hinchey Alameda

2 Northern Harrier fluffing up his feathers Susie Kelly Marin

3 Magic at the Dickens Fair Ken Osborn Berkeley

4 Moody and Mysterious Mono Lake Bruce Finocchio Peninsula

5 Sunset seen from Crown Memorial Beach, Alameda CA Hans Siebert Alameda

HM Burano Italy Wendy Hannum Marin

HM Sunrise at Wonder Lake, Denali National Park Linda Rutherford Peninsula

HM Waiting for Day Dorothy Weaver Marin

Pictorial Projected (cont’d)

Pictorial Projected - 1st - Masters 

Coming down for a landing 
Stephen Hinchey 

Alameda Photographic Society 

Best in Competition - Pictorial Projected
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Monochrome - Projected (Judge - Gary Crabbe)
Basic Level (25 entries)

Award Title Member Club

1 Stormy evening at Vestrahom, Iceland Bob Gingg Marin

2 Taking a work break Jeffrey Blum Marin

3 Peaceful shroud over the oaks Marcy Zimmerman Diablo Valley

4 Dressing Room Madness Derek Moeller Peninsula

5 Board ready, suit ready, I’m ready Previenn Sosa Estrada Santa Rosa

HM Arches Fan Xie Peninsula

HM Reddish egret, Bolsa Chica wetlands reserve Dianne Lee Contra Costa

HM Showtime; green room ready for Project Nunway Elizabeth Springs Santa Rosa

HM The Cathedral in Oakland is appropriately called “Christ the Light.’ Bruce Lescher Livermore

Monochrome Projected - 1st - Basic 
 

Stormy evening at Vestrahorn, Iceland 
Bob Gingg 

Marin Photo Club 
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Intermediate Level (27 entries)

Award Title Member Club

1 White Pelicans on Black Dennis Rashe Livermore

2 To the Bodega Bay Church. Infrared Steve Gibbs Santa Rosa

3 Jillian in Black and White Stephen Hinchey Alameda

4 Nautilus Jennifer Isaac Marin

5 The Miracle of Life John Drake Berkeley

HM Beautiful Black and White Sherri Oster Santa Rosa

HM Coyote in Mid Pounce Yosemite Douglas Smith Contra Costa

HM Once a busy and prosperous little hair salon…in the days 
before social distancing Bill Lapworth Peninsula

HM Pilings, Columbia River Mary Macey Butler Marin

Monochrome - Projected (Cont’d))

Monochrome Projected - 1st - Intermediate 
 

White Pelicans on Black 
 Dennis Rashe 

Livermore Valley Camera Club 
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Monochrome - Projected (Cont’d)
Advanced Level (30 entries)

Award Title Member Club

1 The San Francisco-Oakland Bay Bridge from Water Level Jim Koski Villages

2 Following the Arches Abby O’Rourke Diablo Valley

3 Drenched Dog Rich Budde Marin

4 Luminous Antlers Linda Koski Villages

5 Team Work Susan Stanger Livermore

HM Easter Lily Peche Turner Millbrae

HM Harley engine Stephen Renwick Peninsula

HM Sky light at the Guggenheim, NYC Dean McCoy Livermore

HM The Eyes Have It Cathy Seleska Diablo Valley

Monochrome Projected - 1st - Advanced 
 

The San Francisco - Oakland Bay Bridge From Water Level 
Jim Koski 

Villages Camera Club 
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Monochrome - Projected (Cont’d)
Masters Level (30 entries)

Award Title Member Club

1B Zebras in the Mist Ed Oswalt Berkeley

2 The Big Wave, South Death Valley Nik Favretto Peninsula

3 Through the Noren curtain John Erve Millbrae

4 Normally crowded 101 California is virtually deserted as Bay 
Area citizens shelter-in-place Steve Disenhof Marin

5 Architectural Flame Janet Reinstra Contra Costa

HM A Boy in Sri Lanka with women washing clothes in the river Maureen McGettigan Marin

HM Drip Jamie Wasson Contra Costa

HM Of days gone bye Lance Guelfo Diablo Valley

HM Two Sides to Every Story.  Africa 2020 Tamara Krautkramer Santa Rosa

Monochrome Projected - 1st - Masters 
 

Zebras In The Mist   
Ed Oswalt 

Berkeley Camera Club 

Best in Competition - Monochrome Projected
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Travel - Projected (Judge - Gary Crabbe)
Basic Level (21 entries)

Award Title Member Club

1
Parachicos in the Fiesta Grande of Chiapas. The dance of the 
Parachicos is a traditional celebration in January in the town of 
Chiapa de Corzo, state of Chiapas, Mexico. 

Rafael Ramirez Alameda

2
Moms gather at the Berlin Wall, Berlin, Germany. Vrubel painted 
his "Fraternal Kiss" in 1990 on remains of the wall, from the '79 
photo of Brezhnve and Honecke 

Elizabeth Springs Santa Rosa

3 Vendors at Cairo Marketplace Kenneth Mark Berkeley

4
Angkor Wat Group Shot - Indochinese women frequently seen 
in colorful costume dresses to be photographed at the 12th C. 
Angkor Wat Temple, Cambodia.

Diane Kay Marin

5 A pot of tea anyone? Tea Kettle Junction Death Valley Kathryn Baechle Villages

HM Cross country skiers tees a break in Jackson Hole Wyoming Matt Gallaway Villages

HM
Falconry dates back more than 2000 years in Arabia and 
visitors to Dubai can experience flying birds of prey, like this 
desert eagle owl, rewarded with a rodent held in Mark's glove. 

Carol Wiebe Berkeley

Travel Projected - 1st - Basic 
 

Parachicos in the Fiesta Grande of Chiapas. The dance of the Parachicos is 
a traditional celebration in January in the town of Chiapa de Corzo, state of 

Chiapas, Mexico.  
Rafael Ramirez 

Alameda Photographic Society 
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Travel - Projected (Cont’d)
Intermediate Level (20 entries)

Award Title Member Club

1B
Afternoon traffic jam (AKA Lamb Jam); Maras, Peru. The orange 
dye on the head is to identify the owner, as they tend to graze 
together

Phil Fisher Marin

2
The Palace of Versailles, principal royal residence of France under 
Louis XIV, is visited by 7,700,000 visitors a year. Now a UNESCO 
World Heritage site, the palace still serves political functions 

Ron Shattil Berkeley

3 A boat navigates the waterways of Zhujiajiao, the Venice of 
Shanghai, established 1700 years ago Udo Klein Contra Costa

4
Fern Canyon, It is a World Heritage site and International 
Biosphere Reserve., Praire Creek Redwoods State Park, 
Humboldt, Cal 

Vicki Anderson Contra Costa

5 Demon Statues of South Gate Entry Bridge, Angkor Thom, 
Cambodia Joey Pollack Villages

HM A crisp fall morning view from the Historic Many Glacier Hotel, 
Glacier National Park, Montana. Lynda Stuber Santa Rosa

HM An early morning smoke and chat at the pub in Portrush, N.Ireland Peter Ligeti Villages

Travel Projected - 1st - Intermediate 
 

Afternoon traffic jam (AKA Lamb Jam); Maras, Peru. The orange 
dye on the head is to identify the owner, as they tend to graze 

together  
Phil Fisher 

Marin Photo Club 

Best in Competition - Travel Projected
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Travel - Projected (Cont’d)
Advanced Level (25 entries)

Award Title Member Club

1
Amid clouds of marble dust, artisan creates statues of 
Buddha for Burmese monasteries, Mandalay, Myanmar, 
2016

Jamie Wasson Contra Costa

2 The Pedestrian Millennium Bridge spans the River Thames, 
connecting the South Bank with the City of London Janet Reinstra Contra Costa

3 The Guindais funicular climbs the steep hill behind the 
Ribeira neighborhood in Porto, Portugal Bill Clark Santa Rosa

4
In addition to big hats, Dallas boasts big murals. "The 
Storm," by Chris Arnold and Jeff Garrison, faces the 
downtown Performing Arts Center a block away.

Jeff Dunn Alameda

5 A lone hiker descends through the labyrinth of canyons on 
the Golden Canyon trail - Death Valley National Park, CA Herbert Gaidus Santa Rosa

HM 5 of the 19 mid 18th century windmills at Kinderdijk are part 
of largest concentration of windmills in the Netherlands. Richard Finn Livermore

HM
Fountians Abby is part of Studley Royal Water Garden and 
Deer Park. It is a World Heritage Site and part of the UK 
National Trust.

Dean McCoy Livermore

HM
Most transport is human-powered in Old Delhi - a bustling 
shopping district where the streets are too narrow and too 
crowded to allow cars and trucks

Bill Stacy Santa Rosa

Travel Projected - 1st - Advanced 
 

Amid clouds of marble dust, artisan creates 
statues of Buddha for Burmese monasteries, 

Mandalay, Myanmar, 2016  
Jamie Wasson 

Contra Costa Camera Club 
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Travel - Projected (Cont’d)
Masters Level (22 entries)

Award Title Member Club

1
At an elevation over 10,000 feet, the magnificent Aiguille du 
Midi, a mountain in the Mont Blanc within the French Alps, is an 
alpine skiers' paradise.

Shinnan Kiang Livermore

2
This young woman was forced to wear these neck rings since 
she was a child, because of a Karen tribe tradition in Northern 
Thailand.

Phil Meginness Livermore

3 Chapulines are Roasted Crickets .They are a Staple of the Diet in 
Oaxaca, Mexico. They are Often Flavored with Chile or Lime. Steve Napoli Berkeley

4 History repeats itself; discovery and exploration of a Gentoo 
Colony, Antarctica Peninsula Wendy Hannum Marin

5 Foggy morning on the holy Ganges River in Varanasi, India Tamara Krautkramer Santa Rosa

HM Fishing while sitting on poles in Sri Lanka. The pole enables the 
fishermen to have a better view of the fish. Maureen McGettigan Marin

HM Fog envelops San Francisco, CA Liz Lawson Santa Rosa

HM Night market, San Miguel de Allende, MX Ron McGinnis Marin

Travel Projected - 1st Masters 
 

At an elevation over 10,000 feet, the magnificent Aiguille du Midi, a mountain 
in the Mont Blanc within the French Alps, is an alpine skiers' paradise.  

Shinnan Kiang 
Livermore Valley Camera Club 
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Journalism - Projected (Judge - Gary Crabbe)
Basic Level (22 entries)

Award Title Member Club

1

Despite Coronavirus concerns, approximately 300,000 people 
converged on the streets of San Francisco's Chinatown to 
celebrate the 62nd annual Chinese New Year street fair on 
February 8, 2020.

Michael Isola Millbrae

2 The Oblivious Absence of Empathy ; (Pacifica Municipal Pier, 
March 1, 2020) Jonathan Honneyman Millbrae

3 Dredging the Alameda Estuary to accommodate ever larger ships 
is a never ending project. Leonard Stanton Alameda

4

In March, 2020 as the Covid -19 virus spread people began 
panic buying. Although there is no shortage of food in the U.S. 
the supply channels could not keep up resulting in empty 
grocery shelves.

Dennis Tungate Livermore

5 On December 20, 2019 Mayor London Breed visit the Public 
Works Operations Yard to thank front line staff for their work. Rafael Ramirez Alameda

HM
The 2018 Kilauea fissure number 8 flow reaches the ocean, 
traveling 15 miles to the Issac Hale Park. Lava often flowing 1/4 
mile wide and 40 mph.

Elizabeth Springs Santa Rosa

HM Women’s march in San Francisco Debasish Raha Millbrae

Journalism Projected - 1st Basic 
 

Despite Coronavirus concerns, 
approximately 300,000 people 

converged on the streets of San 
Francisco's Chinatown to celebrate the 
62nd annual Chinese New Year street 

fair on February 8, 2020.  
Michael Isola 

Millbrae Camera Club 
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Intermediate Level (22 entries)

Award Title Member Club

1 Coronavirus concerns cause panic shopping at a Pleasant Hill 
Safeway Jamie Wasson Contra Costa

2
Ms. Liberty joins a large group of demonstrators in El Cerrito, 
California. They are calling for impeachment on the night of 
December 17, 2019.

Vern Muhr Berkeley

3 Shelter-in-Place to Combat COVID-19 Suspended Most 
Shopping and Community Activities in Pleasanton Al Ludwick Livermore

4 Blue Angels Riding The Wave - San Francisco Fleet Week 2016 Jerry Neece Villages

5
San Leandro Police officers direct traffic around a car that has 
just crashed into a fire hydrant at the busy intersection of 
Bancroft and E. 14th. February 19, 2020

Bruce Lescher Livermore

HM
The Grand Princess sails past San Francisco, headed to the 
Port of Oakland, to disembark its passengers some possibly 
infected with the Covid-19 virus. San Francisco, California 

Gary Oehrle Livermore

Journalism - Projected (cont’d)

Journalism Projected - 1st Intermediate 
 

Coronavirus concerns cause panic shopping at a 
Pleasant Hill Safeway  

Jamie Wasson 
Contra Costa Camera Club 
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Advanced Level (24 entries)

Award Title Member Club

1
Nate Hodges with his fast modified hot saw cuts his log in record 
time, 1second/27 milliseconds, taking Logging Champion and 1st 
place, at the Sierra Logging Jamboree Sept,2020

Cindy Micheli Livermore

2 Endeavour, first space flight May 1992 - last space flight May 2011 
- Flyover at Moffet field prior to be set up for static display, CA Gordon Jalkemo Villages

3

Between February and March, as almond trees blossom, honey 
bees (Apis mellifera) forage for pollen and nectar. When the bees 
move between trees, they pollinate almond blossoms along the 
way.

Abby O’Rourke Diablo Valley

4 A rarely seen medicine man dance with emphasis on the light of 
the Tarahumara Indian tribe, Chihuahua Mexico. Phil Meginness Livermore

5 [Seq] Mural Ron Shattil Berkeley

HM Action at the net during one of the volleyball games at the AVP 
tournament in San Francisco in 2018. Eddy Lehrer Alameda

HM Black Cowboy with Daughter, October 4, 2014, BLACK COWBOY 
STREET FAIR, Oakland, CA Susan Dunn Alameda

HM Red Fox, a BI-Plane appearing at the Travis Air Show, 
demonstrating Barrel Roles. Gary LaMusga Diablo Valley

Journalism - Projected (cont’d)

Journalism Projected - 1st Advanced 
 

Nate Hodges with his fast modified hot saw 
cuts his log in record time, 1second/27 

milliseconds, taking Logging Champion and 
1st place, at the Sierra Logging Jamboree 

Sept, 2020.  
Cindy Micheli 

Livermore Valley Camera Club 
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Journalism - Projected (cont’d)
Masters Level (23 entries)

Award Title Member Club

1B

Jacob sits calmly as a Tattoo Artist works on his back during the 
29th Annual Santa Rosa Tattoo Festival which was held at the 
Flamenco Hotel. Artisans came from around the country to the 
event.

Terry Connelly Santa Rosa

2 Bernie at the Richmond Shipyard. 2020. Mara Phraner Alamda

3
Frog jumping contest at Calaveras County Fair was made 
famous by Mark Twain's story. It attracts international attentions. 
Here is a Japanese participant

J.R. Hsu Contra Costa

4 [Seq] Kushti Rajani Ramanathan Livermore

5
Eric Swanson from Menifee, Ca, Does Large Jump in his 
Monster Truck named Obsessed, at the freestyle Competition 
Alameda Fair, CA 2019

Jane Postiglione Contra Costa

HM After tagging out Adam Jones, Mike Lowrie throws to first base 
for double play out! Amory Donaldson Diablo Valley

HM [Seq] CSUEB Takedown Hans Siebert Alameda

HM [Seq] Truckee California hot air balloon enthusiasts perform a 
practice balloon raising Michael Fredrich Livermore

Journalism Projected - 1st Masters 
 

Jacob sits calmly as a Tattoo Artist works on his back 
during the 29th Annual Santa Rosa Tattoo Festival which 

was held at the Flamenco Hotel. Artisans came from 
around the country to the event.  

Terry Connelly 
Santa Rosa Photographic Society 

Best in Competition - Journalism Projected
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Northern California Council of 
Camera Clubs

N4C 
hJp://www.n4c.org    
hJp://n4c.photoclubservices.com 

PSA 
hJp://www.psa-photo.org 

Yerba Buena Chapter of PSA 
hJp://www.psa-yerbabuenachapter.org/Home_Page.html 

N4C Camera Clubs

AL Alameda Photographic Society hJps://alameda.photoclubservices.com/default.aspx

BK Berkeley Camera Club hJp://www.berkeleycameraclub.org/

CC Contra Costa Camera Club hJp://contracostacameraclub.org

CT Chinatown Photographic Society  hJp://chinatownphoto.org/wordpress/en/

DV Diablo Valley Camera Club hJps://diablovalley.photoclubservices.com

FR Fremont Photographic Society hJp://fremont.photoclubservices.com/

LS Light & Shadow Camera Club hJp://light-and-shadow.org/

LV Livermore Valley Camera Club hJp://livermorevalleycameraclub.com

MR Marin Photography Club  hJp://www.marinphotoclub.com/

ML Millbrae Camera Club hJp://www.millbraecameraclub.org/

PE Peninsula Camera Club hJp://www.peninsulacameraclub.com/

PH Photochrome Camera Club of San Francisco hJp://photochrome.org/photochrome_club

RO Rossmoor Photography Club hJp://rossmoorcameraclub.photoclubservices.com/

SC Santa Clara Camera Club hJp://www.sccc-photo.org

SR Santa Rosa Photographic Society hJp://www.santarosaphotographicsociety.org/

VC Villages Camera Club hJps://villages.photoclubservices.com

http://www.n4c.org/
http://n4c.photoclubservices.com
http://www.psa-photo.org
http://www.psa-yerbabuenachapter.org/Home_Page.html
http://www.n4c.org/
http://n4c.photoclubservices.com
http://www.psa-photo.org
http://www.psa-yerbabuenachapter.org/Home_Page.html
https://alameda.photoclubservices.com/default.aspx
http://www.berkeleycameraclub.org/
http://contracostacameraclub.org
http://chinatownphoto.org/wordpress/en/
https://diablovalley.photoclubservices.com/default.aspx
http://fremont.photoclubservices.com/
http://light-and-shadow.org/
http://livermorevalleycameraclub.com
http://www.marinphotoclub.com/
http://www.millbraecameraclub.org/
http://www.peninsulacameraclub.com/
http://photochrome.org/photochrome
http://rossmoorcameraclub.photoclubservices.com/
http://www.sccc-photo.org
http://www.santarosaphotographicsociety.org/
https://villages.photoclubservices.com/default.aspx
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N4C Officers & Committee Chairs
President Doug S7nson Fremont douglas-s7nson@comcast.net

Vice President Stephen Busch Contra Costa 22fretz@gmail.com

Treasurer Jon d’Alessio Marin dalessiojon@comcast.net

Secretary Mark Brueckman Alameda Photographic 
Society

markbrueckman@gmail.com

PI Chair Gene Albright Berkeley genea.genea@sbcglobal.net

Print Chair Joan Field Contra Costa joan421@comcast.net

Judges Chair Joe Hearst Livermore joe@jhearst.com

PSA Representa7ve Joe Hearst Livermore joe@jhearst.com

Special Programs Chair Joan Field Contra Costa joan421@comcast.net

Foto FanFare Editor Vicki Stephens Livermore vjs.1194@gmail.com

Webmaster Stephen Hinchey Alameda shinchey@barbary.com 

N4C Mission Statement
To promote a spirit of voluntary coopera7on among the camera clubs of 
Northern California. To sustain and increase an interest in the science and art 
of photography among photographers of said area. To promote social and 
educa7onal programs for the benefit of member clubs. To create and maintain 
a representa7ve body which will serve the best interests of all member clubs 
and groups and aJempt to provide workable solu7ons to their individual and 
collec7ve problems. To provide services and facili7es for the use and benefit of 
the member clubs.

N4C Calendar 
Board Meetings 

April 13 at 7:30pm (Zoom Mtg.) 
May 11 at 7:30pm  (Zoom Mtg.)                         


Competition Judging Schedule 
On/around the 3rd Saturday of each month 
PI judging location - contact Gene Albright (genea.genea@sbcglobal.net) 
Print judging location - contact Joan Field (joan421@comcast.net)


mailto:genea.genea@sbcglobal.net
mailto:joan421@comcast.net
mailto:genea.genea@sbcglobal.net
mailto:joan421@comcast.net
mailto:douglas-stinson@comcast.net
mailto:22fretz@gmail.com
mailto:dalessiojon@comcast.net
mailto:markbrueckman@gmail.com
mailto:genea.genea@sbcglobal.net
mailto:joan421@comcast.net
mailto:joe@jhearst.com
mailto:joe@jhearst.com
mailto:joan421@comcast.net
mailto:vjs.1194@gmail.com
mailto:shinchey@barbary.com
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N4C Inter-club Competition 
2020 CompeRRon Year

Print Print Print Print PI PI PI PI

Jan Millbrae P M N C P N C

Feb Contra Costa P M T J P T J M

Mar
Livermore 

Valley P M S J P N C

Apr Diablo Valley P M N C P T J M

May Fremont P M T J P N C J

Jun Millbrae P M N C P T J M

Jul Santa Clara P M T J P N C

Aug Rossmoor P M S T P T J M

Sep Marin P M N C P N C T

Oct
Light & 
Shadow P M T J P T J M

Nov Peninsula P M N C P N C

P =Pictorial M = Monochrome N = Nature T = Travel C = CreaRve

J = Journalism S = Sequence

Go to n4c.org/compe77ons for more informa7on regarding N4C interclub compe77ons. 

* No compe77ons scheduled in December.

http://n4c.org/competitions
http://n4c.org/competitions

